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Introduction 

Do you need to get your work done with the Office:Mac 2011 applications—smoothly, easily, and 
quickly? Good! You’ve picked up the right book. 

Who Is This Book For? 
This book is designed to help beginning and intermediate users get up to speed quickly with the 
Office:Mac 2011 applications and immediately become productive with them. 

If you need to learn to use Word, Excel, PowerPoint, and Outlook to get everyday tasks done, 
at work or at home, you will benefit from this book’s focused approach and detailed advice. You 
can either start from the beginning of the book and work through it, or use the Table of Contents 
or the Index to find the topic you need immediately, and then jump right in there. 

What Does This Book Cover? 
This book contains five parts that cover the shared Office features and the four applications. 

Part 1 of the book brings you up to speed with the common features that the Office 
applications share:  

• Chapter 1, “Getting Started with Office 2011,” introduces you to Office’s 
four applications—Word, Excel, PowerPoint, and Outlook—and what you 
can do with them. You learn how to open and close the applications; you 
meet key features such as the new Ribbon interface; and you create, save, 
close, and reopen documents.  

• Chapter 2, “Learning Common Tools Across the Office Suite,” shows you 
how to control the Office applications using the menus, the toolbars, and 
the Ribbon, and how to make the most of the tools in the Toolbox. This 
chapter also explains Office’s common ways of sharing a document with 
others, how to save time and effort by using the AutoCorrect and 
AutoFormat features the smart way, and how to use the spelling and 
grammar checkers. You’ll also learn how to print documents. 

• Chapter 3, “Working with Text,” shows you how to do everything from 
entering text (using the keyboard or other means) to creating tables and 
hyperlinks. Along the way, you’ll learn how to work with cut, copy, and 
paste, and how to use the Find and Replace features. 
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• Chapter 4, “Using Pictures and Shapes in Your Documents,” teaches you 
how to add visual interest to your Office document by adding pictures and 
shapes. You’ll learn how to insert clip art, pictures (such as photos), and 
shapes; how to rotate and position graphical objects; and how to use 
Office’s tools for making pictures look the way you want them. This chapter 
also covers inserting SmartArt diagrams and arranging graphical objects to 
control which is visible. 

• Chapter 5, “Customizing Office to Suit You,” walks you through 
customizing the toolbars, the Ribbon, and keyboard shortcuts to make the 
applications easier and faster to use. You’ll also learn how to set essential 
preferences in the applications, such as the General preferences and the 
Save preferences. 

Part 2 of the book covers using Microsoft Word, the powerful word processing application: 

• Chapter 6, “Entering Text and Using Views,” shows you how to enter text 
quickly in Word documents. You’ll learn how to select text in advanced 
ways with the mouse and the keyboard, how to move around your 
documents, and how to tell Word where to find your custom templates. 
You’ll also learn to create backup documents automatically, and to make 
the most of Word’s seven different views of a document. 

• Chapter 7, “Adding Style: Formatting Your Documents,” teaches you the 
right way to format a document quickly and consistently by using styles 
rather than applying direct formatting bit by bit. It also shows you how to 
get around your documents by using the Sidebar and the Find feature, and 
how to harness the power of the Replace feature. 

• Chapter 8, “Creating Complex Documents and Layouts,” starts by showing 
you how to use Word’s extra features for creating tables. The chapter then 
explains how to break a document into multiple sections; how to add 
headers, footers, and page numbers; and how to create newspaper-style 
columns of text. You’ll learn to use bookmarks and cross-references, 
develop your documents using Word’s powerful Outline view, and add 
footnotes and endnotes to your documents. 

• Chapter 9, “Creating Business Documents with Mail Merge,” shows you 
how to use Word to create business documents swiftly and efficiently. 
You’ll learn to set up mail merge documents (such as letters or labels), 
connect them to data sources, and save or print the results. 

• Chapter 10, “Revising and Reviewing Documents,” covers how to use 
Word’s features for working with your colleagues on documents. You’ll 
learn how to edit a document either simultaneously or separately, how to 
use the Track Changes feature to mark revisions, and how to integrate 
changes into a document. You’ll also see how to add comments to a 
document and compare two document versions that contain untracked 
changes. 

• Chapter 11, “Printing, Sharing, and Securing Documents,” explains how to 
print an entire document or just parts of it, with or without markup, and 
how to print markup without the document. You’ll also learn how to 
remove sensitive information from documents, create a document you can 
open with earlier versions of Word, and create PDF files from documents. 
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Part 3 teaches you to create spreadsheets and charts with Excel: 

• Chapter 12, “Creating Workbooks and Entering Data,” covers creating 
different types of workbooks in Excel and entering data in them. You’ll 
learn how to navigate the Excel interface, use workbooks and worksheets, 
and use Excel’s views and features to see the data you need. 

• Chapter 13, “Formatting Your Worksheets,” explains how to insert, delete, 
and format rows and columns in worksheets; how to format cells and 
ranges; and how to use the advanced conditional-formatting and data-
validation features to identify unusual values or erratic input. This chapter 
also shows you how to format quickly and consistently with styles, how to 
add headers and footers to worksheets, and how to share workbooks 
effectively with your colleagues. 

• Chapter 14, “Creating Powerful and Persuasive Charts,” teaches you how 
Excel’s charts work and how to add them to your workbooks. You’ll learn 
how to lay out a chart effectively, how to make it look good, and how to 
hide any components you don’t want to display. You’ll even learn how to 
save time by reusing the custom chart formatting you create. 

• Chapter 15, “Crunching Numbers with Formulas and Functions,” makes 
clear the difference between a formula and a function, and shows you first 
how to create custom formulas and then how to use Excel’s built-in 
functions.  

• Chapter 16, “Creating Simple Databases and Solving Business Problems,” 
shows you how to use Excel to create databases for storing and 
manipulating your information. You’ll learn how to enter information into 
a database, how to sort the information, and how to filter it to find only the 
results you want. You’ll also learn how to use the Goal Seek feature and 
scenarios to work out solutions to business problems. 

• Chapter 17, “Manipulating Data with PivotTables,” explains how to use 
Excel’s powerful PivotTable feature to manipulate your data so that you 
can discover the information you need. PivotTables take a few minutes to 
grasp, but you’ll be surprised how easy they are to use. 

Part 4 of the book takes you through creating good-looking, persuasive presentations with 
PowerPoint: 

• Chapter 18, “Starting to Build a Presentation,” gets you started by creating 
a presentation document using either a design template or a content 
template. The chapter then shows you how to add, delete, and rearrange 
slides; how to use PowerPoint’s views effectively; how to develop the 
outline of a presentation; and how to break a presentation into separate 
sections. You’ll also learn how to collaborate with your colleagues on 
creating a presentation. 

• Chapter 19, “Creating Clear and Convincing Slides,” guides you through 
the toughest part of creating a good presentation: creating slides that 
convey your meaning clearly and powerfully. This chapter shows you how 
to plan a presentation, choose suitable layouts (or create your own), and 
add text and other content to your slides. 

• Chapter 20, “Adding Life and Interest to a Presentation,” shows you ways of 
spicing up a presentation by using graphics, movies, sounds, animations, 
and transitions. You’ll also learn how to hide slides to keep them up your 
sleeve and how to build custom slide shows that enable you to reveal only 
part of a larger presentation. 
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• Chapter 21, “Delivering a Presentation Live or Online,” explains how to 
deliver the presentation you’ve created. You can deliver the presentation 
live in person, broadcast it across the Internet, or create a version of the 
presentation that you can share via e-mail or in other ways. You’ll also 
learn how to use PowerPoint’s Presenter view and how to create a handout 
for a presentation. 

Part 5 of the book shows you how to manage your e-mail, schedule, contacts, and tasks with 
Outlook: 

• Chapter 22, “Using E-mail Effectively,” first shows you how to set up 
Outlook to work with your ISP or e-mail provider’s servers. Once Outlook is 
working, you’ll learn how to get around its complex user interface, how to 
send and receive e-mail, and how to manage your messages. 

• Chapter 23, “Keeping Your Contacts in Order,” covers creating contacts 
either from scratch or importing them from your address books, 
spreadsheets, or other sources. The chapter also shows you how to view 
and sort your contacts, add or update their contact information, and 
quickly create communications to your contacts. 

• Chapter 24, “Managing Your Calendar,” brings you up to speed with 
Outlook’s Calendar interface, shows you how to customize it, and teaches 
you to use its views. After that, it explains how to create one-shot 
appointments and repeating appointments, schedule meetings, and 
respond to meeting requests. 

• Chapter 25, “Working with Tasks and Notes,” shows you how to use 
Outlook to define the tasks you need to complete and track your progress 
on completing them. This chapter also explains how to use Outlook’s Notes 
feature to jot down information as you work. 

Conventions Used in This Book 
This book uses several conventions to make its meaning clear without wasting words: 

• Ribbon commands and menu commands: The ➤ sign shows the sequence 
for choosing an item from the Ribbon or a command from the menu bar. 
For example, “Choose Home ➤ Paragraph ➤ Decrease indent from the 
Ribbon” means that you click the Home tab of the Ribbon (displaying the 
tab’s contents), go to the Paragraph group, and then click the Decrease 
Indent button. Similarly, the ➤ sign indicates a menu sequence. For 
example, “Choose Insert ➤ Photo ➤ Picture from File from the menu bar” 
means that you click the Insert menu on the menu bar to open the menu, 
click the Photo item to open the Photo submenu, and then click the Picture 
from File item on the Photo submenu.  

• Special paragraphs: Special paragraphs present information that you may 
want to pay extra attention to. Note paragraphs contain information you 
may want to know; Tip paragraphs present techniques you may benefit 
from using; and Caution paragraphs warn you of potential problems. 
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• Check boxes: The Office applications use many check boxes—the square 
boxes that can either have a check mark in them (indicating that the option 
is turned on) or not (indicating that the option is turned off). This book tells 
you to “select” a check box when you need to put a check mark in the check 
box, and to “clear” a check box when you need to remove the check mark 
from it. If the check box is already selected or cleared, you don’t need to 
change it. 

• Keyboard shortcuts: In the Office applications, you can often save time and 
effort by using a keyboard shortcut rather than a Ribbon command. This 
book uses + signs to represent keyboard shortcuts. For example, “press 
Cmd+S” means that you hold down the Cmd key, press the S key, and then 
release the Cmd key. “Press Cmd+Option+T” means that you hold down 
the Cmd key and the Option key, press the T key, and then release the Cmd 
key and the Option key. 



 

 

   Part 

Building Essential 
Office Skills 
To save you time and effort, the Office:Mac 2011 applications share many common 

features. This part of the book shows you how to get started quickly with the 

applications and learn to use these common features. 

In Chapter 1, you’ll quickly meet Office’s four main applications—Word, Excel, 

PowerPoint, and Outlook—and learn what you can do with them. You’ll grasp essential 

moves, such as opening and closing the applications; and you’ll create, save, close, and 

reopen documents.  

In Chapter 2, you’ll take control of the applications using the menus, the toolbars, and 

the ribbon. You’ll learn how to share a document with others, how to save time and 

effort by using the AutoCorrect and AutoFormat features the smart way, and how to use 

the spelling and grammar checkers. You’ll also learn how to print documents. 

In Chapter 3, you’ll study how to work with text—everything from entering text using the 

keyboard to creating tables and hyperlinks. By the end of the chapter, you’ll also know 

how to work with cut, copy, and paste, and how to use the Find and Replace features. 

In Chapter 4, you’ll add visual interest to your Office document by inserting pictures and 

shapes. You’ll learn how to insert clip art, pictures (such as photos), and shapes; how to 

rotate and position graphical objects; and how to use Office’s tools for making pictures 

look the way you want them. When you need more complex illustrations, you can add 

SmartArt diagrams and arrange graphical objects to overlap each other, with fine control 

over which object is visible. 

In Chapter 5, you’ll make the Office applications easier and faster to use by customizing 

the toolbars, the Ribbon, and keyboard shortcuts. You’ll also learn how to set essential 

preferences in the applications, such as the general and save preferences. 
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   Chapter 

Getting Up to Speed with 
the Office Applications 
You’re probably in a hurry to start being productive using Office 2011, so this chapter 

gets you moving quickly. First, you’ll meet each of the applications, find out what you 

can do with them, and come to grips with key features such as the Ribbon and the 

toolbars. Then, I’ll show you how to launch the applications or make them launch 

themselves. Finally, you’ll look at how to create, save, and close documents, as well as 

how to reopen them when you need to work on them again. 

Meeting the Office Applications and Learning What 
You Can Do with Them 
Microsoft Office 2011 comes in two versions and includes either three or four main 

applications, which this section briefly introduces. The basic version, Microsoft Office 

Home & Student, includes Microsoft Word, Microsoft Excel, and Microsoft PowerPoint; 

the more expensive version, Microsoft Office Home & Business, adds Microsoft Outlook 

to those three applications. This book shows you how to become proficient with these 

four applications.  

NOTE: Apart from the four main applications, Office also includes the Microsoft Messenger 
instant messaging application, the Microsoft Communicator telephony and conferencing 
application, the Remote Desktop Connection application for connecting remotely to Windows 
computers, and the Microsoft Document Connection application for connecting to SharePoint 

sites and Windows Live SkyDrive. This book focuses on the four main applications and doesn’t 

cover the others. 

For ease of use and to save time, the four main applications share many features, from 

the ways in which you create, save, and open documents to common actions you 

1 
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perform in them, such as copying text from one part of a document and pasting it in at 

another part. 

Part 1 of this book discusses these common features. Parts 2 through 5 of the book 

then examine each of the applications in turn. 

Microsoft Word 
Microsoft Word (see Figure 1–1) is a word processing application that you can use to 

create everything from a single-page letter to a 1,000-page book complete with a table 

of contents, an index, and cross-references between different parts of the book. 

 

Figure 1–1. Microsoft Word is the Office application for creating text-based documents. 

Part 2 of this book explains how to make the most of Microsoft Word. 



CHAPTER 1:  Getting Up to Speed with the Office Applications 5 

Microsoft Excel 
Microsoft Excel (see Figure 1–2) is a spreadsheet application that you can use to record, 

calculate, and analyze data. Excel includes features for creating many different types of 

charts for presenting your data clearly and effectively. 

 

Figure 1–2. Each Microsoft Excel workbook contains as many worksheets as you need for entering and analyzing 
your data.  

Part 3 of this book shows you how to work quickly and effectively in Microsoft Excel. 
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Microsoft PowerPoint 
Microsoft PowerPoint (see Figure 1–3) is an application for creating and delivering 

presentations. Each presentation consists of slides, to which you can add any data from 

straightforward text to charts and movies. You can also add animations and transition 

effects to provide visual interest. 

 

Figure 1–3. In Microsoft PowerPoint, you create slides and organize them into slide shows. 

Part 4 of this book covers creating persuasive presentations in PowerPoint and 

delivering them to your audience either in person or online.  


